A Principled Technologies report: Hands-on testing. Real-world results.
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Lighten the administrative load
with Dell Client Command Suite

The tool enabled faster and less complicated
device management on a Dell OptiPlex 7050
Micro Desktop with Intel AMT technology

Your IT administrators are responsible for what often seems like a
never-ending log of tasks. These tasks range from the simple—like
helping an employee change their password—to the more complex,
like updating software for different user groups.

Wouldn't it be better if all their tasks were simple? The more

work your administrators can complete in a day, the better your
business flows. Tools such as Intel® Active Management Technology
(AMT), which is part of the set of Intel vPro™ technologies, can
improve management capabilities, but learning the software can

be a time-consuming challenge. With integrations for Intel AMT
and an easy-to-use GUI, Dell Client Command Suite can lessen

the administrative burden and help your admins finish more tasks
each day.

At Principled Technologies, we compared common device
management tasks on two sets of Dell OptiPlex 7050 Micro
Desktop computers. Though we managed both sets in a Microsoft
environment, one set used the Dell Client Command Suite, while
the other set did not. We found that the devices with Dell Client
Command Suite were easier to manage than those without. Faster,
simpler device management can help your admins close out
support tickets more quickly, resolving issues that could otherwise
slow down the speed of your business.

Simpler to use

The DelllGUI makes setting
up Intel AMT easier than a
manual approach.
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_Faster device
~ management

Up to 99.5% less
admin time on several
common tasks

More efficient
_management

A
pdate any number of
devices simultaneously
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The technologies we used

Computers with Intel Core™ vPro™ processors come with Intel Active Management Technology (Intel AMT), a
set of tools built into the system’s motherboard that enhance management capabilities. Intel AMT, however, is a
complex piece of software. Dell Client Command Suite is a host of integrations that simplify and build upon the
strong foundation of Intel AMT to deliver a streamlined management experience.

In our tests, we compared management in three scenarios: Using Dell Client Command Suite to remotely
manage Dell desktop devices; using only Intel AMT to remotely manage the desktops; and directly managing
the desktops without Dell Client Command Suite or Intel AMT. In each of our tests, it was faster for an
administrator to complete management tasks through Dell Client Command Suite rather than completing tasks
with Intel AMT alone, or through direct, manual management. The diagram below shows our test scenarios:
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Without Dell Client ‘ ’
Command Suite . .
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Figure 1: Logical diagram of Dell Client Command Suite management

* Task sequences to configure or disable AMT on'the target client.

* Reports with information on:

* Out-of-band manageability (BIOS version"s\‘, firm\‘ware versions, and/other informatidn from AMT)

* Provisioning information (date, time, certifigate info)
* Battery health for laptop devices

* Hardware inventory reports: the model names'\of younentire fleet, as well as information on processors,
RAM, storage, networks, and IP addresses

* Ability to monitor the state of any device in your flee
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An admin’s story: Saving time with Dell Client Command Suite

Eva's workplace recently started using Dell Client Command Suite to improve how the company manages
their employee devices. Even though Eva is new to using Intel AMT, the Dell integrations make it easy for
her to jump right in.

First on Eva’s task list: Configuring the employee

devices to enable the features that come with Intel AMT.

Thanks to the intuitive GUI in Dell Client Command
Suite, this poses little trouble. If she had to work with

Intel AMT directly, Eva would have to spend hours, days,
even weeks working with her IT department to configure

certificates, Microsoft Active Directory, AMT profiles,
and more—all just to get the solution up and running.

With the help of Dell Client Command Suite, that setup

time shrinks to a few minutes.

With Command Suite, it takes Eva 48 seconds to

configure Intel AMT on a single device, compared to 51

seconds without Dell Client Command Suite (ignoring
research time). Thanks to the one-to-many capabilities

that come with Command Suite, Eva takes just 48
seconds no matter how many devices she needs to
configure. Whether it's five, ten, or a hundred devices,

the steps are identical. Without Dell Client Command
Suite, the amount of hands-on time grows with each
additional device.

et Mdninistrator Password Enter

Figure 3: Editing BIOS settings via Intel AMT

It's the same story whether Eva’s configuring BIOS settings or changing security settings for the company’s fleet: she

saves time by interfacing with Dell Client Command Suite as opposed to approaching the job manually.

Dell Client

L ELUE]
Task (1 system) | command Suite | Intel AMT only admin
Provisioning
Intel AMT 48s N/A 51s
Changing 10 . ] .
BIOS settings Tmin 355 Tmin 45s Tmin 48s
Changing 28s 45s 42s

security settings

Table 1: Time to manage one Dell OptiPlex system (tested)

Task (100 Dell Client :
systems) Command Suite | IMtel AMT only | Manual admin
Provisioning _

Intel AMT 48s N/A | 1h 26min 39s
Changing 10 ) ] .

BIOS settings Tmin 35s 2h 46min 45s | 2h 53min 24s
Changing 28s 1Th 11min 42s | 1h 10min 00s

security settings

Table 2: Time to manage 100 Dell OptiPlex systems (estimated)

Table 1 details how much time Eva would spend on
each of the tasks we tested versus the time it would take
without Dell Client Command Suite.

Extrapolating to 100 systems reveals an even starker
contrast. With Dell Client Command Suite, you can
finish a management task for all your target devices

in one sitting. Without the tool, you'd have to
configure the devices one at a time. Table 2 shows our
extrapolated figures.

Managing an employee fleet with Dell Client Command
Suite is also much simpler than managing manually or
via Intel AMT alone. For example, changing the admin
password for 100 devices took seven steps with the Dell
suite, 400 steps manually, and 601 steps when using
only Intel AMT. For a detailed steps breakdown for the
tasks we tested, see the results appendix on page 19.
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How Dell Client Command Suite saves valuable admin time

How does Dell Client Command Suite save so much time? A variety of factors add up to make management with
Dell Client Command Suite less time-intensive than managing through Intel AMT alone.

Ease of setup

Dell Client Command Suite uses

a clean GUI to walk you through
Intel AMT configuration, using
information you provide to set up
the solution for you. Without Dell
Client Command Suite, setting up
Intel AMT can take many hours of
research, trial, and error if you aren’t
already an expert.

One-to-many administration

Traditionally, managing employee
devices requires working with each
device individually. This adds up to a
lot of time wasted for management
tasks that need to be applied

en masse.

Dell Client Command Suite saves administrators time
by only requiring single entry of a command before
pushing said command out to any number of employee
devices. Through the intuitive GUI, an admin simply
specifies her desired changes and selects the target
systems—that’s the end of their involvement. Dell
Client Command Suite then goes to work, sending the
command to each targeted system and freeing the
admin to take care of whatever's next for the day.

Thanks to this one-to-many capability, Eva takes the
same amount of time no matter how many devices

she configures. Whether it’s five, ten, or a hundred
devices, Eva's time commitment is the same—minimal
and streamlined. Without Dell Client Command Suite,
the amount of hands-on time grows proportionally with
each additional device.

Manage devices from anywhere with Intel AMT

Out-of-band administration

A feature of Intel AMT, out-of-band

management means administrators

can push updates to employee

devices regardless of whether they're

turned off or disconnected from

your office network. Combined with
one-to-many administration, this means Eva can push
updates to hundreds of machines and not have to
worry about whether someone’s computer is offline or
out of power.

Task sequences

In Dell Client Command Suite, task

sequences are automated scripts that

run locally on the target client. Dell

Client Command Suite comes with a

task sequence that configures Intel

AMT on target systems. Without the
task sequence, Eva would have to manually configure
each device, taking up hours of her time.

All these features add up to a more manageable
management solution for admins. By the end of
the day, Eva is glad her company chose to invest in
the technology.

OptiPlex 7050

Management with AMT can take place from any of your offices, no ma
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Conclusion

Managing a fleet of employee devices can be a challenging and time-consuming affair for your administrators to
handle. But with the right tools, admins could finish their management tasks faster and dedicate their valuable
time to other mission-critical work.

At Principled Technologies, we investigated how using Dell Client Command Suite could affect the device
management process. We found that the tools afforded by Dell Client Command Suite allow for faster and
simpler device management compared to completing tasks manually. The ease of configuring Intel AMT
combined with task sequences, out-of-band management capabilities, one-to-many administration, and
other features make Dell Client Command Suite an attractive management solution for fleets with Intel
vPro technology.
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On January 17, 2018, we finalized the hardware and software configurations we tested. Updates for current and
recently released hardware and software appear often, so unavoidably these configurations may not represent
the latest versions available when this report appears. For older systems, we chose configurations representative

of typical purchases of those systems. We concluded hands-on testing on February 1, 2018.

Appendix A: System configuration information

Processor

Vendor Intel®

Name Core™ i5
Model number 75007

Core frequency (GHz) 27-33
Number of cores 4

Cache 6 MB L3
Memory

Amount 8 GB

Type DDR4

Speed 2,400 MHz
Graphics

Vendor Intel

Model number HD Graphics 630
Storage

Amount 1TB

Type 7,200 RPM
Connectivity/expansion

Wired internet Intel 1219-LM

1xUSB 3.1 Gen 1 Type-C Port

Use 5xUSB 3.1 Gen 1 Port
T
Display

Size (in.) 22

Type LED Backlit

Resolution 1,920 x 1,080
Touchscreen No

Lighten the administrative load with Dell Client Command Suite
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System Dell OptiPlex 7050 Micro Desktop

Operating system

Vendor Microsoft

Name Windows 10 Pro
Build number or version Build 16299 (1709)
BIOS

BIOS name and version Dell 1.6.5
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Appendix B: How we tested
Testing Setup

Setting up the Microsoft SCCM environment

Configuring Windows Server 2016

After installing Windows Server on our golden VM and installing all updates up to 01/19/2018, we configured Windows by making the
following changes. We then cloned the VM to a template to use for all VMs.

Configuring Windows Update

In the left pane of the Server Manager window, click Local Server.

In the main frame, next to Windows Update, click Not configured.

In the Windows Update window, in the main pane, click Let me choose my settings.

Under Important updates, select Never check for updates (not recommended), and then click OK.
In the left pane, click Check for updates, and install all available updates.

SR o

Close the Windows Update window.

Configuring Windows Firewall

In Server Manager, click Tools>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.

In the Domain Profile tab, for Firewall state, click Off.

In the Private Profile tab, for Firewall state, click Off.

In the Public Profile tab, for Firewall state, click Off.

Click OK.

Close the Windows Firewall Properties window.

No ok~ wh =

Setting up Remote Desktop
1. In the Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.

2. In the System Properties window that appears, in the Remote Desktop section, select the Allow remote connections to this computer
radio button, and click OK when the warning message appears.

3. Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication (recommended) and
click OK.

Disabling IE Enhanced Security Configuration

1. Inthe Local Server tab of the Server Manager window, next to |IE Enhanced Security Configuration, click On.

2. Inthe Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both Administrators and Users, and
click OK.

Installing and configuring the infrastructure server

We cloned our Windows Server 2016 DC VM to create an Active Directory VM, a Certificate Authority VM, and a System Center
Configuration Manager VM.

Configuring AD/DNS/DHCP

Power on the Active Directory VM.

On the Active Directory server, open Windows PowerShell® as administrator.
Run the following command: Install-WindowsFeature RSAT-ADDS
When the installation is finished, close PowerShell.

Open Server Manager.

On the Welcome screen, click 2, and click Add roles and features.

At the initial Before you begin screen, click Next three times.

At the Server Roles screen, select Active Directory Domain Services.

On the pop-up window, click Add Features.

0. Click Next three times.

SO NOGO R WN -
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11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

Verify the desired role is being installed, and click Install.

Once installation has finished, close the Add roles and features wizard.

In Server Manager, click the flag at the top, and select the Promote this server to a domain controller link.
Select Add a new forest, enter a root domain name of test.local, and click Next.

On the Domain Controller Options screen, enter a password, and click Next.

On the DNS Options screen, click Next.

On the Additional Options screen, click Next.

On the Paths screen, click Next.

On the Review Options screen, click Next.

On the Prerequisites screen, verify all prerequisites have passed, and click Install.

Once Active Directory Domain Services finishes installing, click Finish, and restart the system.

Adding DHCP

© Nk wDd =
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Open Server Manager.

On the Welcome screen, click 2, and click Add roles and features.

At the initial Before you begin screen, click Next three times.

At the Server Roles screen, select DHCP Server.

On the pop-up window, click Add Features.

Click Next three times.

Verify the desired role is being installed, and click Install.

Once installation has finished, close the Add roles and features wizard.

In Server Manager, click the flag at the top of the screen and select Complete DHCP configuration.
In the DHCP Post-Install configuration wizard window, click Next.

At the Authorization Screen, click Commit.

At the Summary screen, click Close.

In Administrative Tools, open the DHCP service.

Expand ad.test.local, then right click IPv4 and select New Scope

In the New Scope Wizard window, click Next.

At the scope name screen, name the scope Laptops, and click Next.

In the IP Address Range, enter the desired scope settings for your network.
Click Next four times.

At the Router screen, enter the gateway address to be used by the clients, and click Next.
Click Next three times.

At the Completing the New Scope Wizard screen, click Finish.

Creating Containers and Extending the AD Schema

© Nk wDd =

On the Domain Controller, run ADSI Edit.

On the toolbar, select Action>Connect to...

Accept the defaults by clicking OK.

Under Default Naming Context>DC- test, DC=local, right-click CN = System, and select New—>Object...
Select Container, and click Next.

Under Value, enter System Management. Click Next, and click Finish.

Run Active Directory Users and Computers.

On the toolbar, select View, and click Advanced Features.

Under test.local>System, right click System Management. Choose Delegate Control.

Click Next.

Click Add.

Click Object Types and select Computers, then click OK.

Enter CM, the computer account for the configuration server, as an object name and click OK.
Click Next.

Select Create a custom task to delegate, and click Next.

Choose This folder, existing objects... and click Next.

Click Full Control, and click Next.

Click Finish.

Attach the SCCM installation media to the VM.

From the installation media, navigate to \SMSSETUP\BIN\X64. Right-click extadsch, and run as administrator.
Review extadsch.log at the root of the system drive to confirm the operation was successful.
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Creating Active Directory accounts for System Center Configuration Manager

1. On the Domain Controller, open Active Directory Administrative Center

2. Under test (local), in the Tasks panel, click New, and select Group from the drop-down menu.
3. Inthe Create Group window, use the following options:

¢ Group name: Kerberos Admins
* Group type: Security
* Group scope: Global

Add Kerberos Admins as a member of the Domain Admins group.

Add the computer account of the SCCM server to the Kerberos Admins security group and click OK.
Create an Organizational Unit for AMT managed systems called AMT Managed.

Create a security group called AMT Control.

No ok

Configuring the environment

Configuring Post Active Directory Deployment

1. On the Certificate Authority and Configuration Manager servers, change the name of the server. For Certificate Authority, name it CA.
For the Configuration Manager server, name it CM.

2. Set a static IP address for each server.
3. Join each server to the domain using the Join domain option.

Adding the configuration manager server as a trusted server

On the Certificate Authority and Configuration Manager servers, run lusrmgr.msc
Select Groups.

Right-click Administrators, and click Properties.

Click Add.

Select Object Types, check the box for Computers, and click OK.

Add the computer name for the management server.

ok wbhN =

Installing SQL 2016

1. Log into the Configuration Manager server as domain\administrator.
2. Attach the installation media for SQL 2016, and run the setup.exe file.

3. Inthe SQL Server Installation Window, select Installation from the menu on the left, and select New SQL Server stand-alone installation
or add features to an existing installation.

In the SQL Server 2016 Setup Window, allow it to check prerequisites. When this is process is complete, click Next.
In the SQL Server 2016 Setup Window, at the Product Updates screen, click Next.

At the Install Setup Files screen, allow the wizard to install the files.

At the Setup Support rules screen, click Next.

At the Product Key screen, enter a valid product key, and click Next.

At the License Terms screen, accept the license terms, and click Next.

At the Setup Role screen, select SOL Server Feature Installation, and click Next.

230N A
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At the Feature Selection screen, under Instances Features, select Database Engine Services with Full-Text and Semantic Extractions for
Search and Data Quality Services, Reporting Services - Native, and SQL Client Connectivity SDK. Click Next.

Allow the Installation Rules check to run, and click Next.
At the Instance Configuration screen, select Default Instance and leave the default Instance ID.
At the Disk Space Requirements screen, click Next.

[N
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At the Server Configuration screen, set Startup Type for Server Agent, SOL Server Database Engine, and Server Browser as Automatic,
and click Next.

16. At the Database Engine Configuration screen, select Mixed authentication mode, and add a password.
17. Click Add Current user.

18. Click Next three times.

19. Verify that the Summary is correct, and click Install.

20. Click finish when prompted.

21. Download Microsoft SQL Server Management Studio 17.4 from https://docs. microsoft.com/en-us/sql/ssms/download-sgl-server-
management-studio-ssms, and install using all defaults.

22. Open Microsoft SQL Server Management Studio.
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23. Sign into your SQL database.

24. Right-click your SQL host, and select Properties.

25. Select the memory page.

26. Change the minimum server memory to 8192.

27. Change maximum server memory to 16384. Click OK.

28. Click SQL Server Services in the tree.

29. Right-click SQL Server (Instance Name).

30. On the Log On tab, change the Account Name to test\administrator.
31. A popup will request to restart the service. Select Yes.

Installing the Certificate Authority

1. On the Certificate Authority Server, log in using the test.local\administrator account.

2. Launch Server Manager.

3. Click Add roles and features.

4. Inthe Add Roles and Features Wizard, click Next three times.

5. Select Active Directory Certificate Services. On the pop-up, click Add Features. Click Next.
6. Click Next until you reach the confirmation screen.

7. Click Install. When complete, click Close.

8.  In Server Manager, click the flag, and select the Post-deployment Configuration task.

9. Inthe AD CS Configuration Window, click Next.

10. Check the box for Certification Authority, and click Next.

11. Select Enterprise for the setup type, and click Next.

12. Choose Root CA for the CA type, and click Next.

13. Select Create a New Private Key, and click Next.

14.  Accept all remaining defaults, and click Next through the remaining screens.

15. When prompted to begin configuration, click Configure.

16. To exit the wizard, click Close. Restart the server before continuing to the next steps.

Creating certificate templates for out-of-band management
Sign into ca.test.local using the domain\administrator account.

Open the Certification Authority.

Right-click the test-CA-CA, and click Properties.

On the General tab, click View Certificate.

On the Details tab, scroll to and select Thumbprint. Copy the 40-character code displayed in the details. You will add this information to
the AMT BIOS later.

6. Click Ok to close the Certificate Authority properties.

ko=

Create the AMT provisioning certificate

Expand the Certification Authority, and select Certificate Templates.

Right-click Certificate Templates, and select Manage.

Locate Web Server in the list of available certificate templates. Right-click the template, and select Duplicate Template.

Select Windows 2003.

In the General tab, change the template name to AMT Provisioning.

On the General tab, choose the option Publish Certificate in Active Directory.

On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and choose the option UPN.
On the Request Handling tab, check the box for Allow private key to be exported.

On the Security tab, add Kerberos Admins and domain computers. Add the Enroll permission for the security group. Ensure
administrators and domain computers have Enroll permissions.

10. On the Extensions tab, select Application Policies, and click Edit.

11. Click Add. Click New. Type AMT Provisioning for the name, and 2.16.840.1.113741.1.2.3 as the Object Identifier. Click OK.
12. Ensure AMT Provisioning and Server Authentication are listed, and click OK.

13. Click OK to close the template properties.

Vo Nk WD~

Create the AMT Web Server Certificate

1. Right-click the web server template, and select Duplicate Template.
2. Select Windows 2003AMT.
3. Onthe General tab, change the template name to AMT Web Server Certificate.
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On the General tab, choose the option Publish Certificate in Active Directory.
On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and choose the option UPN.
On the Security tab, ensure Domain Admins and Enterprise Admins have Enroll permissions.

No vk

Click OK to close the template properties.

Issue the certificate templates to Issue

In Certification Authority, expand test-CA-CA.

Right-click the Certificate Templates and select New-> Certificate Template to Issue. If it is not available, restart the virtual machine.
Select the AMT Provisioning Template.

Click OK.

Repeat steps 2-4 for the AMT Web Server Certificate Template.

ko=

Request the certificates on the Configuration Manager server
Log into the Configuration Manager server as domain\administrator.

Click Start>Run. Type mmc, and press Enter.

In the mmc console, click File>Add/Remove Snap-in...

Select Certificates, and click Add. Select Computer account. Click Next.
Select Local computer, and click Finish.

Click OK.

Expand Certificates=>Personal.

In the right panel, click More Actions>All Tasks>Request a new certificate...
Click Next.

0. Accept the defaults, and click Next.

1. Select the AMT Provisioning and AMT Web Server Certificate. Click Enroll.

S0 NoeOAEWh =

Installing required Windows features and roles for System Center Configuration Manager
1. Sign into cm.test.local using the domain\administrator account.

2. Download the Windows Assessment and Deployment Kit for Windows 10 from the following Web site: https://go.microsoft.com/fwlink/
p/?linkid=859206

Run adksetup.exe.

Select Install the Assessment and Deployment Kit to this computer, and choose an installation path. Click Next.
Select Deployment tools, Windows Pre-installation Environment features, and User State Migration Tool. Click Install.
When the install finishes, click Close.

Run the following commands in Windows PowerShell with administrator privileges:

No ok w

Get-Module servermanager
Install-WindowsFeature Web-Windows-Auth
Install-WindowsFeature Web-ISAPI-Ext
Install-WindowsFeature Web-Metabase
Install-WindowsFeature Web-WMI
Install-WindowsFeature Web-DAV-Publishing
Install-WindowsFeature BITS
Install-WindowsFeature RDC
Install-WindowsFeature NET-Framework-Features -source \\yournetwork\yourshare\sxs
Install-WindowsFeature Web-Asp-Net
Install-WindowsFeature Web-Asp-Net45
Install-WindowsFeature NET-HTTP-Activation
Install-WindowsFeature NET-Non-HTTP-Activ

8. Run Windows Update, and install updates.
9. Restart the server.

Installing System Center Configuration Manager 1702
Sign into cm.domain using the domain\administrator account.
Attach the SCCM 1702 Installation media to the management server.
Open splash.hta.

Click Install.

Read the Before You Begin section, click Next.

Choose Install a primary site. Choose use typical options.

Noahs~wDd =~

Enter the product key.
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8.  Check the box to accept the License Terms, and click Next.

9. Accept the license agreements, and click Next.

10. Enter a path for the prerequisite file downloads. We used C:\Downloads

11. Select a language, and click Next for both server and client.

12. Enter a site code for the primary site. We used PTT.

13. Enter a Site Name. We used PT Test.

14. Click Next twice.

15. On the Settings Summary Screen, click Next.

16. Ensure that the console will be installed, and click Next.

17. Install as a primary stand-alone site.

18. Enter the SQL server name, and click Next.

19. Leave the default Database information, and click Next.

20. Accept the default SMS provider, and click Next.

21. Select the option to Configure the communication method on each site system role.
22. Select Clients will use HTTPS when they have a valid PKI certificate and HTTPS-enabled site roles are available, and click Next.
23. Select HTTP for Management Point and Distribution point, and click Next.

24. Select | don't want to join the program at this time, and click Next.

25. Click Next.

26. Run the prerequisites check, and resolve any issues displayed.

27. Click Begin Install, and click Close when the installation is complete.

28. Download and install the installation for System Center R2 SP1 Configuration Manager from the following website: support.microsoft.
com/kb/2922875/en-us

29. Download and install the cumulative update.

Configuring SCCM for Intel AMT testing

This is not required for testing Dell Client Command Suite and is completed only for the Intel AMT use cases.

1. Inthe SCCM console, under Administration->Site Configuration, click Server and Site System Roles.
2. Right-click cm.test.local, and select Add Site System Roles.

3. Inthe Add Site System Roles Wizard, click Next twice.

4. Select the Fallback status point, and click Next.

5. Click Summary.

6. Click Next.

Installing Intel Setup and Configuration Software (SCS) 11.1

Download IntelSCS_11.1.zip from https://downloadcenter.intel.com/download/26505.

Extract the contents to C:\IntelSCS_11.2.

Browse to C:\IntelSCS_11.2\IntelSCS\RCS.

Run IntelSCSInstaller.exe.

At the Welcome screen, click Next.

Select | accept the terms of the license agreement, and click Next.

Check the Boxes for Remote Configuration Service (RCS), Database Mode, and Console.

Enter the credentials of the Domain account that will run the service. We used test.local\administrator. Click Next.

W o NGk wWwN =

Select cm.test.local as the location for the SCS database. This information may populate automatically. Select Windows Authentication,
and click Next.

10. On the Create Intel SCS Database pop-up, click Create Database.

11. On the confirmation screen, click Close.

12. On the confirmation screen, leave the default Installation Folder, and click Install.
13. Once the installation is complete, click Next.

14. Click Finish.

Installing the provisioning certificate

1. Open MMC, and add the certificates snap-in, targeted at the local computer.
Navigate to Personal, Certificates.

Right-click the AMT Provisioning Certificate, and choose Open.

On the Details tab, click Copy to file.

On the Welcome screen, click Next.

o~
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6. On the Export Private Key screen, choose Yes, export the private key, and choose Next.

7. On the Export File Format screen, check the boxes for Include all certificates in the certification path if possible and Export all extended
properties. Click Next.

8.  On the Password screen, enter a password to protect the private key.
9. On the File to Export screen, enter C:\Install_Files\scs-prov-cert.pfx, and click Next.
10. On the Completed screen, click Close.
11. From an elevated command prompt, run the following commands:
\SCS_download pacakge 11.2.0.35\utils\RCSutils.exe
/Certificate Add c:\Install Files\scs-prov-cert.pfx Passwordl

net stop rcsserver
net start rcsserver

12.  To verify, run the following command, and make sure the expected certificate is listed:
RCSUtils.exe /certificate view /RCSuser NetworkService /log file C:\rcsout.txt

Creating the AMT configuration profile

On the management server, launch the Intel Setup and Configuration Console.

Click Profiles.

To construct a profile for deployment, click New.

For Profile Name, enter a description of the target clients. We used wireless. Click OK.
On the Getting Started Screen, choose Configuration / Reconfiguration.

On the Optional Settings screen, choose the options Active Directory Integration, Access Control List (ACL), and Transport Layer
Security (TLS), Network Configuration, Wired 802.1x and click Next.

7. On the AD Integration screen, browse for the OU created for the AMT managed devices. We used OU=AMT, DC=test, DC=local.
Click Next.

8. On the Access Control List screen, click Add.
9. Select Active Directory User/Group. Click Browse.
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10. Add Kerberos Admin, Domain Admins, or other administrative users groups. Click OK.

11. For Access Type, select Remote.

12. Choose the option for PT Administration. Click OK.

13. Click Next.

14. On the TLS screen, from the drop-down menu, select the Enterprise Certificate Authority, ca.test.local.

15. Select the Server Certificate Template to be used to generate certificates for the AMT devices. We selected AMTWebServerCertificate.

Click Next.
16.  On the Network Configuration Screen, select Allow Wired connection with the following WiFi setups.
17. Click Add...

18. On the 802.1x Setup screen, click Edit list.
19. Click Add, then use the test-CA certificate authority. Click OK.
20. Click OK.
21. On the System Settings screen, choose the options Web Ul, Serial Over LAN, IDE Redirection, and KVM Redirection.
22. Select Use the following password for all systems. Enter the password for use after provisioning is complete. We used P@sswOrd
23. Enter the RFB Password for KVM sessions. We used P@sswOrd
24. Enter the MEBX password. We used P@sswOrd
25. Click KVM Settings..., uncheck User Consent required before beginning KVM session, and click OK.
26. Check the boxes for the following options:
a. Synchronize Intel AMT clock with operating system
b. Enable Intel AMT to respond to ping requests
c. Enable Fast Call for Help (within the enterprise network)
27. To Edit IP and FQDN settings, click Set.
28. In the Network Settings window, select Use the following as the FQDN, and choose Primary DNS FQDN from the drop-down menu.
29. Choose the option that indicates the device and the OS will have the same FQDN (Shared FQDN).
30. Select Get the IP from the DHCP server.
31. Select Update the DNS directly or via DHCP option 81. Click OK.
32. Click Next.
33. Click Finish.
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Adding the configurator to a shared folder

1. Create a shared folder called amtshare
2. Copy the file at C:\IntelSCS_11.3\IntelSCS\Configurator to the shared C:\amtshare folder.

Installing certificates on target systems

Configuration for our laptop varied from this since we used a self-signed certificate. In order to configure the system, we first manually input
our configuration information into the pre-boot MEBx menu. This work around will not be necessary for users who purchase their certificates.

On each target system, during boot, press Ctrl + P to enter the Intel Management Engine BIOS Extension.
Enter the Intel ME Password. The default is admin. We changed ours to P@ssw0rd

Navigate to Intel ME General SettingsRemote Setup and Configuration, TLS PKI, and select Manage Hashes.
Press the insert key to add a certificate hash.

Enter a name for the hash.

Enter the 40-character thumbprint recorded before.

. Exit the MEBx menu.
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Testing methodology

Before each test, ensure all target desktops are powered on and are signed out of the user account. Ensure that all systems are domain
joined and that they have the configuration manager client installed prior to running the provisioning command. Ensure all systems are
connected to a monitor.

Dell desktop with Command Suite

At the beginning of all tests, the administrator is logged into the management server at the desktop. Tests in this section require additional
time for the commands to complete during which the administrator is not actively inputting commands. We refer to this as system time. We
have recorded both admin time and system time in Appendix C.

Configuring AMT
Prior to this test, ensure all target clients have been added to the target collection.

On the Configuration Manager server, open the configuration manager console.

Open the Assets and Compliance panel.

Open Device Collections.

Right-click the collection that you wish to deploy to, and select Deploy->Task Sequence.
In the Deploy Software Wizard, next to Task Sequence, click Browse.

Select the vPro-AMT Configure Client task sequence, and click OK.

In the Deploy Software Wizard, click Next.

Next to Purpose, select Required, and click Next.
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9. Select a time when the deployment will become available, and click Next.
10. On the user experience screen, click Next.

11. On the Alerts screen, click Next.

12. On the Distribution Points screen, click Next.

13. On the Summary screen, click Next.

For timing purposes, we used RDP to connect to the target system and ran a Machine Policy Retrieval & Evaluation Cycle using the
Configuration Manager Properties menu in Control Panel to trigger the install.

For the two-system test, we completed steps 1 through 13 once, but added the additional client to the collection prior to running the test.

Changing one BIOS setting

Open the Dell Intel vPro Out of Band plugin.

Under Client Configuration, select BIOS Settings.

On Active Processor Cores, select All, and check the Apply checkbox. Click Next.
Add the target system and click Next.

Add a description, and click Next. We typed test.

Click Finish.

For the two-system test, we completed steps 1 through 6 once, but selected all systems in step 4.

S o
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Changing 10 BIOS settings

1. Open the Dell Intel vPro Out of Band plugin.

2. Under Client Configuration, select BIOS Settings.

3. For Auto On, check the box, and select Every day.

4.  For Active Processor Cores, check the box, and select All.
5. For Enable Audio, check the box, and select Enabled

6. For SATA-O, check the box, and select Enabled.

7.  For Trusted Execution, check the box, and select Enabled.
8. For Intel TurboBoost, check the box, and select Enabled.
9. For Front USB Ports, check the box, and select Enabled.

10. For USB Rear Port 1, check the box, and select Enabled.

11. For VT for Direct 1O, check the box, and select Enabled.

12. For Wake on LAN, check the box, and select LAN or WLAN. Click Next.
13. Select the clients to add.

14. Click Next.
15. Add a description.
16. Click Finish

For the two-system test, we completed steps 1 through 16 once, but selected all systems in step 13.

Changing the Boot Order

Open the Dell Intel vPro Out of Band plugin.

Under Client Configuration, select Boot Order.
Select only Internal HDD (IRRT) boot and click Next.
Add the target system and click Next.

Add a description and click Next. We typed test.
Click Finish.

For the two-system test, we completed steps 1 through é once, but selected all systems in step 4.
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Setting a system password on the target system

Open the Dell Intel vPro Out of Band plugin.

Under Client Configuration, select Passwords.

Select Set, and select Administrator.

Enter and confirm a BIOS Password, and click Next. We used Passwordl.
Add the target system, and click Next.

Add a description, and click Next. We typed test.

Click Finish.

For the two-system test, we completed steps 1 through 7 once, but selected all systems in step 5.
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Wiping the Client Data on the target system
Open the Dell Intel vPro Out of Band plugin.

Under Operations, select Wipe Client Disk.

Add the target system and click Next.

Add a description and click Next. We typed test.
Click Finish.

We do not include time or steps for this task, but did complete it to verify functionality.
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Enabling Intel vPro without the Dell Command Integration Suite
We completed this test for the Dell desktops and recorded it as a manual task.

Log into the target system over RDP using test\administrator.

Navigate to the shared folder on the configuration server, and copy the Configurator folder onto the desktop.
Open the target folder.

Click File, navigate to Open command prompt, then click Open command prompt as Administrator.

Run the following command in the elevated command prompt:

AR e

ACUConfig.exe /Verbose /Output console ConfigViaRCSOnly cm.test.local test
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After starting the previous command, stop the admin time timer, and start the system time timer. Stop the system time timer and once the
command stops running and exits with code 0, indicating a successfully provisioned system.

For the two-system test, repeat steps 1-5 for the second system. Immediately start repeating the above steps on the second system and do
not start the system time timer till you complete the steps for the second system.

Conducting the Intel vPro and manual tests

We used the steps in the sections below for both vPro and Manual tests. vPro tests use vPro's KVM feature to complete the task. Manual tasks
are completed at the target desktop’s console.

For all vPro tests, we use Intel Manageability KVM to complete the task.

1. Open the Intel Manageability Connector.

2. Connect to the target system.

3. Click Remote Desktop.

We added these steps to the total steps for all vPro tasks. Additionally, all two-system tests repeat steps 2 through 3 for the second system.

Changing one BIOS setting

For vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when
connected via the Intel Manageability Commander.

Reboot the target client to System Setup.

Under Performance, select Multi Core Support.

For Multi Core Support, select All.

Click Exit and click Yes when prompted to save changes.
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For the two-system test, repeat steps 1 through 4 on the second system.

Change 10 BIOS settings

For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when
connected via the Intel Manageability Commander.

1. Reboot the target client to System Setup.

2. Under System Configuration, select Drives.

3. For SATA-0, check the box for SATA-0.

4. Under System Configuration, select USB Configuration.
5. Check the box for Enable Front USB Ports.

6. Under System Configuration, select Front USB Configuration.
7. Check the box for Front Port 1 w/ Power Share(Bottom)*.
8. Under Onboard Audio Controller, click Audio.

9. Check the box for the Enable Audio option.

10. Under Performance, select Multi Core Support.

11. For Multi Core Support, select All.

12. Select Intel TurboBoost.

13. Check the Box for Enable Intel Turboboost.

14. Under Virtualization Support, select Virtualization.

15. Check the box for Enable Intel Virtualization Technology.
16. For Direct I/0, Select VT.

17. For Direct I/0O, Check the box for Enable VT.

18. Select Trusted Execution.

19. Check the box for Trusted Execution.

20. Under Power Management, select Wake on LAN/WLAN.
21. For Wake on LAN/WLAN, select LAN or WLAN.

22. Click Exit and click Yes when prompted to save changes.

For the two-system test, repeat steps 1-22 on the second system.
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Changing the Boot order

For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when
connected via the Intel Manageability Commander.

Reboot the target client to System Setup.
Under General, select Boot sequence.
Select the Onboard NIC and uncheck the box.

Click Exit and agree to save changes.
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For the two-system test, repeat steps 1 through 4 on the second system.

Change the system password

For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, completed the following actions
at the console.

Reboot the target client to System Setup.
In the Dell OptiPlex 7050 setup menu, under security, select Admin Password.
Enter and confirm and the new Password. We used Passwordl.
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Click Exit and click save when prompted.

For the two-system test, repeat steps 1 through 4 on the second system.
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Appendix C: Our results

The tables below show the admin time required to manage one, two, and 100 systems. To estimate the time to perform tasks on 100
systems, we used the formula W + [ 98 x At ], where W is the time to perform a task on two systems, and At is the time difference between

the one- and two-system tests.

Admin time to complete

management tasks (mm:ss)

Single-system tests

Two-system tests

Task Cognrpand AMT only Manual Comrpand AMT only Manual
uite Suite

Provisioning AMT 00:48 N/A 00:51 00:48 N/A 01:43

Changing the boot order 00:21 00:43 00:43 00:21 01:27 01:26

Changing a BIOS setting 00:25 00:51 00:50 00:25 01:40 01:40

Changing 10 BIOS settings 01:35 01:45 01:48 01:35 03:25 03:32

Changing the system password 00:28 00:45 00:42 00:28 01:28 01:24

Admin time to complete management tasks - 100-system extrapolation (hh:mm:ss)

Task Co;nmand AMT only Time saved PerFent Manual Time saved PerFent

uite savings savings
Provisioning AMT 00:00:48 N/A N/A N/A 01:26:39 01:25:51 99.1%
Changing the boot order 00:00:21 01:13:19 01:12:58 99.5% 01:11:40 01:11:19 99.5%
Changing a BIOS setting 00:00:25 01:21:42 01:21:17 99.5% 01:23:20 01:22:55 99.5%
Changing 10 BIOS settings 00:01:35 02:46:45 02:45:10 99.1% 02:53:24 02:51:49 99.1%
Changing the system password 00:00:28 01:11:42 01:11:14 99.3% 01:10:00 01:09:32 99.3%

The tables below show the admin steps required to manage one, two, and 100 systems.

Admin steps to complete

Single-system tests

Two-system test

management task

Task Cog:Jrir;:nd AMT only Manual DCCS AMT only Manual
Provisioning AMT 13 N/A 5 13 N/A 10
Changing the boot order 6 7 4 6 13 8
Changing a BIOS setting 6 7 4 6 13 8
Changing 10 BIOS settings 16 25 22 16 49 44
Changing the system password 7 7 4 7 13 8

Admin steps - 100-system extrapolation

Task Co;nu rir;:nd AMT only | Steps saved Zae\f:g: Manual Steps saved zae\::::gst
Provisioning AMT 13 N/A N/A N/A 500 487 97.4%
Changing the boot order 6 601 595 99.0% 400 394 98.5%
Changing a BIOS setting 6 601 595 99.0% 400 394 98.5%
Changing 10 BIOS settings 16 2,401 2,385 99.3% 2200 2,184 99.2%
Changing the system password 7 601 594 98.8% 400 393 98.2%
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This project was commissioned by Dell Technologies.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of the
possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with Principled
Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.
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